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ACH User Guide
You can use the Pay or Transfer options from the home page to initiate ACH files if you are using templates or importing files.  

Establish a New ACH Payment
You can generate a new ACH payment using the + New payment functionality.

1.	 Sign in to Business Online.  The system displays Business Online.

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.  

3.	 Select ACH.  The system displays the ACH transfer page.

4.	 Select + New payment.  The system displays the New payment dialog box.  

5.	 Select the appropriate Type (for example, Payroll – PPD) from the drop-down list.  Click Continue.  The system 
displays the New payment page.  

6.	 Type the Description of the transfers (for example, Payroll, Invoice, etc.).

7.	 Select the tax identification number that the system associates with the transfer from the Tax identification 
number drop-down list.  

Note: In some instances, the system associates an ACH user (for example, George Washington) with multiple 
companies (for example, Washington Farms and Washington Orchards).  In these cases, the system populates 
the Tax identification number drop-down list with each of the companies that it associates with the user.  

8.	 In the Effective date field, type the date you intend the new ACH transfer to process.

9.	 Optional.  Select the Same day check box to process the transfer the same day.

10.	 Optional.  Select the Repeat check box to establish the frequency with which the new ACH transfer occurs.

a.	 Select the Frequency from the drop-down list to establish how often the transfer occurs.  

Note: When you select a recurring frequency value other than None, the system populates the transfer with an 
additional date field titled End date.  Type the end date of a recurring transfer as the End date.  

11.	 Type the Company description (This is what posts to the originator and receivers account along with 
the company name.  If left blank the first 10 letters/digits of the Description field populates the Company 
Description in the field).

12.	 In the Pay from section, select the appropriate Account from the drop-down list and type the Amount that 
the system debits from the account.  

13.	 In the Pay to section, complete the following:

a.	 Type the Name of the recipient. 
b.	 Optional.  Type the Identification number of the recipient.
c.	 Type the Routing transit number of the recipient.  
d.	 Type the Account number of the recipient.  
e.	 Select the appropriate Account type.  
f.	 Type the Amount to deposit in the recipient’s account.  
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14.	 Click Complete ACH to originate file, the system displays the processing results page.  

a.	 Click Save for later to save the file.
b.	 Click Cancel to terminate file.  

15.	 Click the token and enter the One-Time Password from the token, without the PIN. 

16.	 Click Complete Challenge.

Establish a New ACH Collection
You can generate a new ACH collection using the + New ACH collection functionality.  

1.	 Sign in to Business Online.  The system displays Business Online.  

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.  

3.	 Select ACH.  The system displays the ACH transfer page.

4.	 Select + New Collection.  The system displays the New collection dialog box.

5.	 Select the appropriate Type (for example, Prearranged payment – PPD) from the drop-down list.  Click 
Continue.  The system displays the New collection page.  

6.	 Type the Description of the transfer (for example, Dues, Rent, etc.).

7.	 Select the tax identification number that the system associates with the transfer from the Tax identification 
number drop-down list.  

Note: In some instances, the system associates an ACH user (for example, George Washington) with multiple 
companies (for example, Washington Farms and Washington Orchards).  In these cases, the system populates 
the Tax identification number drop-down list with each of the companies that it associates with the user.  

8.	 In the Effective date field, type the date you intend the new ACH transfer to process.  

9.	 Optional.  Select the Same day checkbox to process the transfer same day.  

10.	 Optional.  Select the Repeat check box to establish the frequency with which the new ACH transfer occurs.  

a.	 Select the Frequency from the drop-down list to establish how often the transfer occurs.  

Note: When you select a recurring frequency value other than None, the system populates the transfer with an 
additional date field titled End date.  Type the end date of a recurring transfer as the End date.  

11.	 Type the Company description (This is what posts to the originator and receivers account along with 
the company name.  If left blank the first 10 letters/digits of the Description field populates the Company 
Description in the field).

12.	 In the Pay to section, select the appropriate Account from the drop-down list and type the Amount that the 
system debits from the account.  

13.	 In the Pay from section, complete the following: 

a.	 Type the Name of the recipient.  
b.	 Optional.  Type the Identification number of the recipient.
c.	 Type the Routing transit number of the recipient.  
d.	 Type the Account number of the recipient.  
e.	 Select the appropriate Account type.  
f.	 Type the Amount to deposit in the recipient’s account.  
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14.	 Click Complete ACH to originate file, the system displays the processing results page.  

a.	 Click Save for later to save the file.
b.	 Click Cancel to terminate file.  

15.	 Click the token and enter the One-Time Password from the token, without the PIN. 

16.	 Click Complete Challenge.

Inquire into an ACH Payment or Collection
You can find information about ACH transfers using Inquire ACH Transfer functionality.  

1.	 Sign in to Business Online.  The system displays Business Online.  

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.  

3.	 Select ACH.  The system displays the ACH transfer page.  

4.	 Type search criteria in the Search Activity area as needed then click Submit.  The system displays a list of 
transfers on the ACH Activity page.  

5.	 Locate the ACH transfer that you want to inquire into and click the down arrow next to the transfer to view a 
brief overview of the transfer.  

6.	 Locate the ACH transfer that you want to inquire into and click on the Description hyperlink that the system 
associates with that particular transfer.  The system displays the ACH transfer details page.  

7.	 Review the ACH transfer.  

8.	 To generate a report, click Report.  The system displays the Transfer report dialog box.  

9.	 Select PDF (.pdf) or Comma separated value (.csv) from the Format drop-down list and click Download report.  

10.	 Click Return to ACH activity.  The system displays the ACH Activity list page.

Modify an ACH Payment or Collection
You can modify ACH transfers using Change ACH Transfer functionality up to two business days before the Effective date.  

1.	 Sign in to Business Online.  The system displays Business Online.  

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.  

3.	 Select ACH.  The system displays the ACH transfer page.  

4.	 Click Edit for the appropriate transfer from the list.  The system displays the edit page for the transfer.  

5.	 In the Description field, modify the name of the transfer as needed (for example, Wash Orchards Payroll 
becomes Wash Orch Pay).

6.	 Select the tax identification number that the system associates with the transfer from the Tax identification 
number drop-down list.  

7.	 Type the date that you intend the ACH transfer to process in the Effective date field.  

8.	 Optional.  Modify the frequency with which the ACH transfer occurs in the Frequency field.  

Note: When you select a recurring frequency value other than None, they system populates the transfer with 
an additional date field titled End date.  Type the end date of the recurring transfer.  
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9.	 Modify the description according to your needs in the Company description field.  

10.	 Modify the information in the fields populating the Pay from section and the Pay to section as needed.  

11.	 Click Complete ACH to originate file, the system displays the processing results page.  

a.	 Click Save for later to save the file.
b.	 Click Cancel to terminate file.  

12.	 Click the token and enter the One-Time Password from the token, without the PIN. 

13.	 Click Complete Challenge.

Approve or Disapprove ACH Transfers
Review ACH Transfer functionality ensures that individual ACH users can review and approve ACH transfers before the 
system processes them.  

1.	 Sign in to Business Online.  The system displays Business Online.  

2.	 Select the appropriate check boxes for the transfers listed in the ACH section of the Payments & Transfers 
widget on the Home page.  

3.	 Select Review ACH Transfer and then click Submit.  The system displays the ACH review ACH Transfers list.  

4.	 Locate the ACH transfers that require review from the ACH section of the Payments Transfers widget on the 
home page and select Approve or Disapprove.  

Note: You can approve or disapprove all of the ACH transfers populating the ACH Transfers list by selection the 
Description check box.  

Delete ACH Transfers
Delete ACH Transfer functionality ensures that an ACH user can delete saved ACH transfers or ACH transfers that have 
not completed processing.  Files can be deleted up to two business days before the effective date.

1.	 Sign in to Business Online.  The system displays Business Online.  

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.  

3.	 Select ACH.  The system displays the ACH transfer page. 

4.	 Use the Search activity fields to narrow the list of ACH transfers that the system returns.  

5.	 Click Delete for the appropriate transfer.  The system displays the Delete transfer page.  

6.	 Click Delete ACH.  The system displays the processing results page.  

7.	 Sign out of Business Online.  
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Establish a New ACH Transfer Using an Existing ACH Transfer
You can generate new ACH transfers using an existing ACH transfer when you use New Change ACH Transfer 
functionality.  

1.	 Sign in to Business Online.  The system displays Business Online.  

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.

3.	 Select ACH.  The system displays the ACH transfer page.  

4.	 Locate the appropriate transfer that you want use and click Copy.  The system displays the [Transfer name] 
page.  

5.	 In the Description field, type the name of the new transfer (for example, Wash Orchards Payroll).

6.	 Select the tax identification number that the system associates with the transfer in the Tax identification 
number drop-down list.  

Note: In some instances, the system associates an ACH user (for example, George Washington with multiple 
companies (for example, Washington Farms and Washington Orchards).  In these cases, the system populates 
the Tax identification number drop-down list with each of the companies that it associates with the user.  

7.	 Type the date that you intend the new ACH transfer to process in the Effective date field.  

8.	 Optional. Select the Same day check box to process the transfer the same business day.

9.	 Optional. Select the Repeat check box to define the Frequency that the transfer occurs, the End date and the 
For Non-business day use option.  

10.	 Type the appropriate information in the fields populating the Transfer from section and the Transfer to section.  

11.	 Click Complete ACH to originate file, the system displays the processing results page.  

a.	 Click Save for later to save the file.
b.	 Click B to terminate file.  

12.	 Click the token and enter the One-Time Password from the token, without the PIN. 

13.	 Click Complete Challenge.

Generating PDF Formatted Reports – Transfers 
Print functionality provides users with the ability to print ACH transfer and ACH transfer template data in the PDF 
format when inquiring into individual transfers and transfer templates.  

1.	 Sign in to Business Online.  The system displays Business Online. 

2.	 Select Payments & Transfers.  They system displays the Payments & Transfers page.

3.	 Select ACH.  The system displays the ACH transfer page. 

4.	 Use the search criteria to narrow the list of transfers and click Search. The system refreshes the page with the 
new search results.  

5.	 Click Report to generate a report for all items that the system displays. The system displays the Activity report 
dialog box.  
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6.	 Select the appropriate Type check boxes (for example, File information, Batch information, or Transactions) 
for the information that you want the system to include in the report.  

Note: If you select more than one Type check box, the system complies the report in a Zip file.  

7.	 Select PDF from the Format drop-down list.

8.	 Click Download report.  When the system prompts you, select the local folder to which you want to save the 
formatted report.

Note: By default, the system generates a PDF formatted report that uses the naming convention 
TransferDetail_MMDDYYYYHHMMSS.pdf.

MM = the month that the system generates to PDF report.
DD = the day that the system generates the PDF report.
YYYY = the year that the system generates the PDF report.
HH = the time of the day in hours that the system generates the PDF report.  
MM = the time of day in minutes that the system generates the PDF report.  
SS = the time of day in seconds that the system generates the PDF report.  

9.	 Once you save or open the PDF formatted report, open the report in Adobe Reader.  The system displays the 
PDF formatted report for the ACH transfer.

10.	 When you complete your review of the report, close Adobe Reader.

Generating PDF Formatted Reports – Templates
Print functionality provides users with the ability to print ACH transfer and ACH transfer template data in a PDF format 
when inquiring into individual transfers and transfer templates.  

1.	 Sign in to Business Online.  The system displays Business Online.

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page. 

3.	 Select ACH.  The system displays the ACH transfer page.

4.	 Click the Templates tab.  The system displays a list of templates.

5.	 Click the Report button.  The system displays the Template report dialog box.  

6.	 Select the appropriate check boxes for the templates that you want to include in the report, select PDF (.pdf) 
from the Format drop-down list and click Download report.  When the system prompts you, select the local 
folder to which you want to save the formatted report.

Note: By default, the system generates a PDF formatted report that uses the naming convention 
TemplateList_MMDDYYYYHHMMSS.pdf.

MM = the month that the system generates to PDF report.
DD = the day that the system generates the PDF report.
YYYY = the year that the system generates the PDF report.
HH = the time of the day in hours that the system generates the PDF report.  
MM = the time of day in minutes that the system generates the PDF report.  
SS = the time of day in seconds that the system generates the PDF report.  

7.	 Once you save or open the PDF formatted report, open the report in Adobe Reader.  The system displays the 
PDF formatted report for the ACH template.

8.	 When you compete your review of the report, close Adobe Reader. 
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Generating CSV Formatted Reports – Transfers
Export functionality provides users with the ability to generate ACH transfers in a CSV formatted report when inquiring 
into individual transfers and transfer templates.  

1.	 Sign in to Business Online.  The system displays Business Online.

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.

3.	 Select ACH.  The system displays the ACH transfer page.

4.	 Use the search criteria to narrow the list of transfers and click Search.  The system refreshes the page with the 
new search results.  

5.	 Click Report to generate a report for all items that the system displays.  The system displays the Activity 
report dialog box.  

6.	 Select the appropriate Type check boxes (for example, File information, Batch information, or Transactions) 
for the information that you want the system to include in the report. 

Note: if you select more than Type check box, the system compiles the report in a Zip file.  

7.	 Select Comma separated values (.csv) from the Format drop-down list.

8.	 Click Download report.  When the system prompts you, select the local folder to which you want to save or 
open the CSV formatted report.  

Note: By default, the system generates a CSV formatted report that uses the naming convention TemplateList_
MMDDYYYYHHMMSS.csv.

MM = the month that the system generates to CSV report.
DD = the day that the system generates the CSV report.
YYYY = the year that the system generates the CSV report.
HH = the time of the day in hours that the system generates the CSV report.  
MM = the time of day in minutes that the system generates the CSV report.  
SS = the time of day in seconds that the system generates the CSV report.  

9.	 Once you save the CSV formatted report, open the report in a program like Microsoft Excel.  The system 
displays the CSV formatted report for the ACH transfer.  

10.	 When you complete your review of the report, close the report.

Generating CSV Formatted Reports – Templates
Print functionality provides users with the ability to print ACH transfer and ACH transfer template data in a CSV format 
when inquiring into individual transfers and transfer templates.  

1.	 Sign in to Business Online.  The system displays Business Online.  

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.

3.	 Select ACH.  The system displays the ACH transfer page.

4.	 Click the Templates tab.  The system displays a list of templates.

5.	 Click the Reports tab.  The system displays the Template report dialog box.  
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6.	 Select the appropriate check boxes for the templates that you want to include in the report, select Comma 
separated value (.csv) from the Format drop-down list and click Download report.  When the system 
prompts you, select the local folder to which you want to save the formatted report.  

Note: By default, the system generates a CSV formatted report that uses the naming convention TemplateList_
MMDDYYYYHHMMSS.csv.

MM = the month that the system generates to CSV report.
DD = the day that the system generates the CSV report.
YYYY = the year that the system generates the CSV report.
HH = the time of the day in hours that the system generates the CSV report.  
MM = the time of day in minutes that the system generates the CSV report.  
SS = the time of day in seconds that the system generates the CSV report.  

7.	 Once you save or open the CSV formatted report, open the report in Microsoft Excel.  The system displays the 
CSV formatted report for the ACH template.  

8.	 When you complete your review of the report, close Microsoft Excel.  

Import a NACHA File Using an Existing Template
Import ACH Transfer functionality for NACHA files enables you to import a stored NACHA transfer file against a stored 
template.  The system validates the transfer type and amount range (total transfer amount) stipulated in a selected 
template against the values in the imported ACH file.  If the validation fails, the system displays an error message and 
the import process cannot continue.  

Note: ACH users who do not have access to stored templates can only import files without using a template.  

1.	 Sign in to Business Online.  The system displays Business Online.  

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.

3.	 Select ACH.  The system displays the ACH transfer page.

4.	 Click the Import file hyperlink.  The system displays the Import file page.

5.	 Select NACHA as the Import type.  

6.	 In the File location field, select Browse.  The system displays the Choose File to Upload window.  

7.	 Select the file to upload and click Open.  The system displays the Import file page.  

8.	 Select the appropriate Template from the drop-down list.

9.	 Select the Tax identification number from the drop-down list.  

10.	 Select the Type from the drop-down list.  

11.	 Click Continue.  The system displays the File summary page.

12.	 Click the Review ACH button.  The system displays the transfer Activity edit page.

13.	 Review the transfer details and make any desired changes, and then click Complete ACH to originate file, the 
system displays the processing results page.  

a.	 Click Save for later to save the file.
b.	 Click Cancel to terminate file.  

14.	 Click the token and enter the One-Time Password from the token, without the PIN. 

15.	 Click Complete Challenge.
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Import a Non-NACHA File Using an Existing Template
Import ACH Transfer functionality for non-NACHA files enables users to import a stored transfer file against an existing 
template.  The ACH transfer system validates the tax identification number, transfer type, and amount range (that is, 
total transfer amount) stipulated in a selected template against the values in the imported ACH file.  If the validation 
fails, the system displays an error message and the import process cannot continue.  

Note: ACH users who do not have access to stored templates can only import files without using a template.  

1.	 Sign in to Business Online.  The system displays Business Online.  

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.

3.	 Select ACH.  The system displays the ACH transfer page.  

4.	 Click the Import file hyperlink.  The system displays the Import file page.  

5.	 Select Non-NACHA.

6.	 In the File location field, select Browse.  The system displays the Choose File to Upload window.  

7.	 Select the file to import and click Open.  The system displays the Import file page.

8.	 Select the appropriate Template from the drop-down list.  

9.	 Click Continue.  The system displays the New NACHA file import template page. 

10.	 Review the content. If the system prompts you, type the Effective date and click Continue.  The system 
displays the Import file [File Name] page.

11.	 Click Complete ACH to originate file, the system displays the processing results page.  

a.	 Click Save for later to save the file.
b.	 Click Cancel to terminate file.  

12.	 Click the token and enter the One-Time Password from the token, without the PIN. 

13.	 Click Complete Challenge.

Import a NACHA File Without Using a Template
Import ACH Transfer functionality for NACHA files enables users to import a stored NACHA transfer file without 
validating it against the fields stored in an existing NACHA template.  

Note: ACH users who do not have access to stored templates can only import files without using a template.  
The import process does not display the Template filed for these users.  

1.	 Sign in to Business Online.  The system displays Business Online.  

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.  

3.	 Select ACH.  The system displays the ACH transfer page.  

4.	 Click the Import file hyperlink.  The system displays the Import file page.  

5.	 Select NACHA.

6.	 In the File location filed, select Browse.  The system displays the Choose File to Upload window.  

7.	 Select the file to import and click Open.  The system displays the Import file page.

8.	 Select Import without using a template from the Template drop-down list.
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9.	 Select the tax ID number from the Tax identification number drop-down list.

10.	 Select the appropriate ACH transfer type from the Type drop-down list.

11.	 Click Continue.  The system displays the Import file – [File Name] page.

12.	 Click Review ACH.  The system displays the transfer Activity edit page.  

13.	 Review the transfer details and make any desired changes, and then click Complete ACH to originate file, the 
system displays the processing results page.  

a.	 Click Save for later to save the file.
b.	 Click Cancel to terminate file.  

14.	 Click the token and enter the One-Time Password from the token, without the PIN. 

15.	 Click Complete Challenge.

Import a Non-NACHA File Using a New Template
Import ACH Transfer functionality for non-NACHA files enables users to import a stored transfer using a new template.  
The system validates the transfer type and any other applicable information.  If the validation fails, a message displays 
and the import process cannot continue.  

Note: ACH users who do not have access to stored templates can only import files without using a template.  

1.	 Sign in to Business Online.  The system displays Business Online.  

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.  

3.	 Select ACH.  The system displays the ACH transfer page.  

4.	 Click the + Import file hyperlink.  The system displays the Import file page.  

5.	 In the Import file section, complete the following:

a.	 Select Non-NACHA.
b.	 Select the File location using the Browse button.
c.	 Select Create a new template from the Template drop-down list.
d.	 Select the ACH transfer type from the Type drop-down list.  

6.	 Click Continue.  The system displays the Import file page with all the import details.  

7.	 Complete the following:

a.	 Type the Template name.  
b.	 Select the Tax identification number from the drop-down list.  
c.	 Select the Template group from the drop-down list.
d.	 Select the appropriate Insert decimals into amounts option.  
e.	 Select Delimited or Fixed width as the file format.  
f.	 Type the number of Header and Footer rows to exclude.  
g.	 Select the Text qualifier from the drop-down list.
h.	 Select all appropriate Column options.  

8.	 In the Apply additional values section select the appropriate Type from the drop-down list.

9.	 In the Offset account options section, select whether you want the system to apply an offset.  

10.	 In the Effective date section, select whether the system use the Date in file, Prompt for date, or the Default 
current business date.  
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11.	 In the User access section, select either All current and future users or Specific users.

12.	 Click Continue.  The system displays the Import file – [Template Name] page which provides an overview of 
the data mapping.  

13.	 Type the Effective date and click Continue.  The system displays the File summary page.  

14.	 Click Complete ACH to originate file, the system displays the processing results page.  

a.	 Click Save for later to save the file.
b.	 Click Cancel to terminate file.  

15.	 Click the token and enter the One-Time Password from the token, without the PIN. 

16.	 Click Complete Challenge.

Send a Prenote
Sending a Prenote will help solve any errors before sending a live file.  

1.	 Create a new file or add to an existing file and locate the Prenote column. It will be set at No. 

2.	 Click the word No to switch it to Yes. This will initiate this specific entry as a prenote.  

Reverse ACH Transfers
Quickly reverse ACH transactions by inquiring into a batch or a specific transaction.  This enables you to easily reverse 
a specific transaction, multiple transactions, or an entire batch.  The system processes reversals and memo posts to all 
affected accounts.  

1.	 Sign in to Business Online.  The system displays Business Online.  

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.  

3.	 Select ACH.  The system displays the ACH Activity page.  

4.	 Click Reverse for the associated transfer.  The system displays the transfer page.  

5.	 Click the No switch below the Reverse column in the Pay to section for the transfer that you want to reverse.

•	 May need to select account if not reversing entire file.

6.	 Click Reverse ACH.  The system displays the ACH List page.  

Establish a New ACH Template
The ACH transfer system provides easy-to-use templates for many transfer types, including payroll, tax payments, 
consumer debits and credits, cash concentrations, disbursements, and vendor payments.  ACH Transfer templates 
enable you to automatically define information about the receiving institution and to add multiple ACH transfers using 
easy to use templates.  You can leverage all templates at any time, without having to reestablish each transfer one at 
a time.  Any time that you generate or process a new template, the system requires approvals in order for it to process 
transfers as accurately as possible.  

Note: To establish templates based on NACHA standard or non-NACHA (fixed width or delimited) file formats, 
use the ACH File Import Template function.  

1.	 Sign in to Business Online.  The system displays Business Online.  

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.  
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3.	 Select ACH.  The system displays the ACH transfer page.  

4.	 Click the Templates tab.  The system displays the list of available templates.  

5.	 Click + New payment template or + New collection template.  The system displays the new template dialog box.  

6.	 Select a type from the Type drop-down list and click Continue.  The system displays the New template page.  

7.	 Complete the following:

a.	 Type a Template name.  
b.	 Select the Tax identification number from the drop-down list.  
c.	 Select the Template group from the drop-down list.  
d.	 Select the Repeat check box if the template is for recurring transfers.  
e.	 Type the From amount.  
f.	 Type the To amount.  
g.	 Select the Frequency from the drop-down list.  

8.	 In the User access section, complete the following:

a.	 To enable the template for all users select All current and future users.  
b.	 To enable the template for specific users, select Specific users.  Select the appropriate check boxes for 

each user that you want to have access to the template.  

9.	 In the Pay from section, complete the following:

a.	 Optional. Type the Account number to filer by the account number of the Originating Depository 
Financial Institution (ODFI).

b.	 Optional.  Type the Amount to filter by the amount to be paid from the specified accounts to be debited.  
c.	 Optional. Type the Identification to filter by the identification number that the system associates with 

the origination of the transfer.  
d.	 Optional.  Type the Name, to filter by the name of the customer that the system associates with the 

account it debits from.  
e.	 Optional.  Click the Pay all switch to turn on the Hold option for all transfers in the batch.  
f.	 Type the Identification. 
g.	 Type the Name.
h.	 Optional.  Type any Discretionary data.
i.	 Optional.  Type the Payment information to include notes about the transfer.  

10.	 In the Pay to section, complete the following:

a.	 Type the Name of the recipient.  
b.	 Optional.  Type the Identification number of the recipient.  
c.	 Type the Routing transit number of the recipient.  
d.	 Type the Account number of the recipient.  
e.	 Select the appropriate Account type from the drop-down list.  
f.	 Type the Amount to deposit in the recipient’s account.  

11.	 Select the appropriate Template Group from the drop-down list.  

12.	 Click Save.
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Edit an ACH Template
You can modify ACH templates using Edit template functionality.  

1.	 Sign in to Business Online.  The system displays Business Online.  

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.  

3.	 Select ACH.  The system displays the ACH transfer page.  

4.	 Click the Templates tab.  The system displays a list of available templates.  

5.	 Click Edit for the template that you want to edit.  The system displays the Edit template dialog box.  

6.	 In the Description section, modify the Template name, Template group, From amount, and To amount as needed.  

7.	 In the User access section, modify any user access specifications as needed.  

8.	 Modify the information in the fields populating the Pay from section and the Pay section as needed.  

9.	 Click Save.  

Delete an ACH Template
Delete Template functionality enables you to delete templates that you no longer have a need for.

1.	 Sign in to Business Online.  The system displays Business Online.  

2.	 Select Payments & Transfers.  The system displays the Payments & Transfers page.  

3.	 Select ACH.  The system displays the ACH transfer page.  

4.	 Click the Templates tab.  The system displays a list of available templates.  

5.	 Click Delete for the template that you want to delete.  The system displays the delete Template page for the 
template that you specified.  

6.	 Click Delete Template.  The system displays the Templates page.  
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ACH File Status

File Transfer Status Meaning

Disapproved File not processed. The secondary approver disapproved the file.

File Not Originated File not processed. 

File Not Originated: Account Balance 
Verification Completed with Errors File not processed. The account does not have enough funds to fund the file. 

File Not Originated: Exceeded Limit File not processed. The daily and/or monthly limit has been exceeded.

File Not Originated: 
Memopost Completed with Errors File not processed. The account does not have enough funds to fund the file. 

Pending Origination File has been submitted and is waiting to be processed. Changes can be 
made to the file if needed.

Processed File has been submitted and fully processed.  If changes are needed, a 
reversal file will need to be originated. 

Recurring Entry
Indicates that the file is an entry that automatically repeats. File will generate 
the next payment on its own based on the frequency that was selected 
when set to recurring. 

Saved File is saved and not originated/processed.

Transfer Exceeds Review: 
Pending Approval

File not processed. Secondary approval is required, and file will not process 
until it is approved. 

User Deleted File is not processed. An existing user has deleted the file. 


